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Congratulations on your purchase of Finale 2007 for Macintosh! 
 
IMPORTANT: Read this document before you begin working with Finale 2007 and print a copy of it to 
keep with your Finale information.  
 
This file contains important information about Finale 2007 not included in the User Manual as well as 
information about converting older files into the new version's format. Please note that Finale 2007 files 
cannot be opened in previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions 
may wish to read only the new information. The Read Me contains the following sections: 
 

Running Finale 2007 
New features in Finale 2007a 
New features in Finale 2007 
Fixes in Finale 2007c 
Fixes in Finale 2007b 
Fixes in Finale 2007a 
Fixes in Finale 2007 

 
You may also visit our web site, www.finalemusic.com for updated information about Finale and 
information on new releases. 
 

Running Finale 2007 
 
System Requirements Change 
Finale 2007 for Mac requires OS X 10.3, 128MB RAM (256MB RAM recommended), and 200MB of free 
hard drive space. 
 
Adobe Acrobat Reader 
The Adobe Acrobat Reader is required to view the User Manual and the electronic version of the 
Installation and Tutorials Manual. 
 
User Manual 
For full documentation on how to run Finale 2007, see the User Manual. To access the User Manual, 
choose the Help menu, then User Manual, then Table Of Contents. 
 
Garritan Personal Orchestra and Human Playback Tutorial Supplement 
See “GPOHP Tutorial Supplement.pdf” in Finale’s User Manual folder for a guide on making the most of 
playback using Garritan Personal Orchestra (GPO) and Human Playback (HP). 
 
Default View 
Studio View, Finale’s view optimized for auditioning playback, is set as the default view. To change the 
default view to Page View or Scroll View, from the Finale 2007 Menu, choose Preferences > Program 
Options and select the New page. Choose the desired default view and click OK.  
 
Authorizing Finale 2007 
The first time you launch Finale, you will be prompted to authorize. To authorize a single copy of Finale, 
click Authorize Now! to open the Authorization Wizard (or, from the Help Menu, choose Authorize 



Finale). Then follow the instructions to authorize your copy of Finale via the Internet, phone, or mail. If 
you choose not to authorize, you will be prompted to do so each time you launch Finale. If you do not 
register within thirty days, printing and saving are disabled until you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Make sure that the Authorization Code is typed in using capital letters, and also verify that the 
correct serial number has been entered. Your copy of Finale can be authorized on two computers 
simultaneously. However, with an Internet connection, authorization can be moved from one computer to 
another at will. Simply choose Deauthorize Finale from the Help Menu to open up a free slot. Your copy of 
Finale can now be authorized on a different computer. When you Deauthorize, printing and saving are 
disabled until authorization has been restored. 
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or installing a new 
operating system), then you will need to re-authorize the installation. If you have already installed and 
authorized twice, you will need to contact Customer Service directly by phone, FAX or standard mail with 
your serial number and the location ID for the specific installation in question, and one of our 
representatives can clear the previous authorization from your account. If the software is not "reminding" 
you to authorize when you run the program, then the registration/authorization has been successfully 
completed. 
 
Sharing Finale Files Online 
Support for the Finale Viewer browser plug-in has been discontinued in favor of Finale NotePad, which 
provides a free, reliable, and easy way to view and playback Finale documents downloaded from the 
Internet. To open a Finale (MUS) file available at Finale Showcase, or another online resource, viewers 
now need to simply download the file to their local machine and then open it in Finale NotePad. This 
paradigm shift eliminates a variety of problems associated with some web browsers, and means that all 
Finale files posted on the Internet will be available for viewing on all machines immediately upon the 
release of Finale NotePad 2007. Finale NotePad is available for download free of charge at 
www.finalemusic.com/notepad. (Note that documents saved in Finale 2007 are only compatible with 
NotePad 2007 which becomes available shortly after the Finale 2007 release. NotePad 2007 will open files 
saved in any Finale version 2007 or earlier.)  
 
Allow Individual Positioning 
Due to ambiguities related to Finale's new Linked Parts feature, each instance of the "Allow Individual 
Positioning" check box (which allowed you to individually position measure expressions or text repeats 
assigned to multiple staves) has been renamed "Allow individual edits per staff."    
 
Rhymer 
The WriteExpress Rhymer feature has been removed from Finale. You will no longer find it under the 
Lyrics Menu. 
 
Dragging while holding down a metatool key on notebook computers 
Some notebook computers are set to limit trackpad mouse movement while typing. As a result, you may 
experience sluggish performance while dragging over items while holding down a metatool key. To resolve 
this, open the Preferences pane and deactivate "Ignore accidental trackpad movements."   
 
Contacting Customer Support 
The phone number for MakeMusic Customer Support is (952) 937-9703. FAX# (952) 937-9760. For online 
support, visit http://support.makemusic.com. 
 
Converting Finale 2006 (and earlier) documents into Finale 2007 documents 
Finale 2007 has a different file format than earlier versions, and converts older files to the new format when 
you open them in Finale 2007. You should be aware of the following points: 
 
Opening old documents 
Finale 2007 will open and convert older versions' documents, giving them the default title 



"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the 
original file, keeping the older unconverted file as a backup. If you do want to save the file using the same 
name, choose Save As from the File menu. Finale displays the original file name, so you can click OK to 
rewrite over the old file. 
 
Running older versions of Finale 
Finale 2006 (and earlier versions) for Windows or Macintosh cannot open any Finale 2007 file, except 
Standard MIDI Files. To share Finale files, the Finale application must have the same (or later) version 
number. 
 
Finale Preferences File 
The Finale Preferences file contains many program settings, from the configuration of your tool palette to 
the display colors you select. Finale stores this file in your System Folder's Preferences folder, although it 
will look first in the same folder for a Preference file. 
 
Finale 2007 does not share the preferences file with older versions of Finale. Finale 2007 will automatically 
load the new Finale 2007 default settings upon launching Finale for the first time. If you would like to use 
preferences from an earlier Finale version of Finale, go to User/Library/Preferences and delete the File 
"Finale 2007 Preferences". (If you are moving preferences from OS 9, go to System Folder/Preferences 
folder, and copy the Finale 2006 Preferences to User/Library/Preferences). Then, rename "Finale 2006 
Preferences", "Finale 2007 Preferences".  
To use Finale's default settings at any time, simply delete the Finale 2007 Preferences file from the System 
Folder/Preferences folder. A new preferences file will be generated the next time you start Finale. 
 
Keep in mind that just as older versions of Finale cannot read the newer version's music files, older 
versions cannot read the newer version's preferences. Please note that older versions of Finale will revert to 
default preference settings each time they sense that Finale 2007 has updated the Finale Preferences file. If 
you think you'll continue to use older versions of Finale and Finale 2007 on the same computer, we 
recommend placing a copy of the Finale Preferences file in the same folder as each Finale program. 
 
New Features in Finale 2007a 

 
Updated Human Playback. New Human Playback features now provide additional choices for 
instrument, technique, action, and filter settings in the Instruments Technique & Effects pane including 
full support for Garritan Stradivari Violin. Also, diminuendos on long ending notes can now be 
disabled. 

Enhanced Scanning Support. Updated to a universal binary format, Finale's SmartScore Lite 
scanning utility now runs natively on Intel-based Macs. 

New Help System. Finale’s contextual help system has been updated for compatibility with Intel-
based Macs. 

 
New Features in Finale 2007 

 
Linked Parts. Content from the score is now intelligently linked to parts so editing the score and part 
documents separately is no longer required. Print parts directly from your main project file. 

Intel-Based Mac Support. As a Universal Binary Application, Finale 2007 runs natively on speedy 
new Intel-based Macs. 

Performance Enhancements. Finale is faster than ever with speed improvements to Mass Edit, page 
navigation, and redraw.   

Latin Percussion plug-in. Use this plug-in to automatically create authentic Latin Percussion rhythm 
section notation, with a variety of styles to choose from.  



Latin Percussion Sounds. You can now make your Latin rhythms sound as good as they look. 

SMPTE/MIDI Time Code Support. Use MTC to synchronize Finale with the integrated Movie 
Window or another MTC-compatible device. 

Integrated On-screen Video. Use Finale’s built-in Movie Window to write to picture. No external 
software required. 

Fit to Time. Instantly assign a duration for any region of music. Finale modifies the tempo to fit the 
music to the time specified. 

Playback Counter. Finale’s Playback Controls now include a counter that displays SMPTE MIDI 
Time Code during playback (hours, minutes, seconds, and frames).  

Time Markers. A new Measure Number Style allows you to view the elapsed time at any measure. 

Change Expressions and Articulations Quickly. Simple key commands can now be used to change 
expression and articulation definitions directly from the score.  

Vertical Collision Remover. Automatically reformat the vertical positioning of staves, systems, and 
instrument groups to avoid collision of notes, articulations, smart shapes and other items.  

Human Playback Improvements. The Human Playback Preferences dialog box now includes specific 
"techniques" designed to give you a completely customizable Human Playback environment. 
Techniques also allow Human Playback to make the most of multiple sound libraries used in the same 
document.  

Kontakt II for Finale with Garritan Personal Orchestra. The new Kontakt player allows you to 
load up to 64 instruments and channels at once. Also, benefit from optimized sample management, 
DFD disk streaming, and more. 

More Control of Groups and Brackets. Groups and brackets can now be edited en masse after a 
score has been optimized.  

Hide Chords, Fretboards, and Lyrics on Individual Staves. Or, hide them on a region of a staff 
with Staff Styles.  

Horizontal and Vertical Scroll Wheel Support. Navigating your score is easier than ever with the 
addition of scroll wheel support, including support for Apple’s Mighty Mouse. 

New QuickStart Videos. Finale’s QuickStart Videos have been updated with a new look and 
additional content to get you up and running even faster. 
 

Fixes in Finale 2007c 
 
Lyrics Tool 
Hyphens are no longer improperly placed too far to the left or right (most apparent at system breaks). 

 
Fixes in Finale 2007b 
 
Mass Edit Tool 
Rebar music no longer condenses empty measures. 
 
Fonts 
The Maestro font's unmeasured tremolo character now displays correctly when printed with a PostScript 
printer. 
 
Human Playback 
Human Playback no longer applies the Finale GPO harp harmonic keyswitch to subsequent notes during 
playback. The keyswitch is now cancelled appropriately.   



 
Fixes in Finale 2007a 
 
Articulation Tool 
The shape preview now appears properly for flipped symbols. 
 
Chord Tool 
New chord symbols now appear at the correct default position. 
Chord suffixes and alterations will now display in italics without requiring a manually change. 
Custom chord suffixes now copy and paste correctly when using the clipboard. 
All suffixes are now included while saving the Figured Bass Chord Suffixes Library. 
A font description now appears in the Change Chord Suffix Fonts dialog box. 
 
Document Options 
Stem Connections cannot be created, edited, or deleted on PowerMacs. 
 
Edit Menu 
Special Part Extraction is now applied each time the command is invoked (instead of every other time). 
 
Exercise Wizard 
The Exercise Wizard now prints the appropriate number of each part. 
 
Expression Tool 
Expressions with enclosures now appear properly in the Expression Designer dialog box immediately after 
they have been created. 
Expressions that are set to break a multimeasure rest now function properly. 
Improvements have been made to expression display in extracted parts.  
 
Extract Parts 
The Open Extracted Part command in the Extract Parts dialog box is now checked by default in all new 
documents and documents created in earlier Finale versions. 
Extracted Parts now observe the part-specific Document Options - Time Signature settings and Document 
Options – Fonts settings. 
When extracting a part, the score's Page Format for Parts settings are now transferred to the part's Page 
Format For Score settings. 
 
File Menu 
Music Spacing Option values are no longer transposed in some old files. 
Key Signature Libraries now function properly. 
 
Help Menu 
Check for Updates preferences can now be accessed without a live internet connection. 
 
Linked Parts 
Using the Clear key on a page or system in a linked part now sets the margins according to the Page Format 
for Parts settings (instead uses the Page Format for Score settings). 
The 13th and subsequent text blocks added to a linked part no longer disappear. 
 
Mass Edit Tool 
Music can now be copied by Option-clicking a highlighted area. 
Dot alterations and tie alterations can now be selected independently in the Items to Clear dialog box.  
 
Measure Tool 
Extraneous options no longer appear after Control-clicking a beat chart handle. 
Measure numbers are no longer converted to a Time style in some cases when an old file is opened. 



The Show Numbers command in the Measure > Measure Numbers submenu now observes both handle 
selection and measure selection. (Previously, it only observed measure selection). 
The language “Restore Defaults” is now used instead of "Reset Defaults" in all cases related to the Measure 
Tool. 
Extra Space at the beginning of a measure in a part is no longer getting byte-swapped. 
 
Other 
Vocal staves are now set to unique channels in Finale's included template files. 
In pre-2001 files, it was possible to mark a note as having a parenthesized accidental without the accidental 
appearing. Finale now addresses such notes so accidentals don't show up unexpectedly. 
 
Program Options 
Edit: The bounding rectangle of the treble clef character no longer extends too far to the right. 
Edit: The “resize” cursors no longer appears in the wrong place in the Font Annotation dialog box. 
 
MIDI Tool 
Kontakt Player 2: There is now a visual indication that sounds are loading. 
 
Playback 
Bank Changes now work properly on Intel Macs. 
Banks loaded into the second bank (or subsequent banks) in the Native Instruments AU dialog box are now 
retained when reopening a file containing very large samples, such as JABB keyswitches. 
Documents will no longer cease to be accessible after attempting, twice, to play a file that uses a VST not 
on your system. 
 
Plug-ins 
Running the Create Handbell Used Chart plug-in will no longer remove 1 or 2 measures from the end of the 
piece. 
The split measure plug-in no longer deletes measures at the end of the document when the plug-in is 
applied.   
 
Printing 
Finale no longer hangs while specifying a Page Range in the Finale section of the Print Panel that doesn't 
include the final page of the document. 
 
Simple Entry Tool 
Changing the pitch of a note which has been altered to its enharmonic equivalent no longer results in 
misspelled notes. 
 
Smart Shape Tool 
Note attached smart shapes that span over multiple pages no longer only show on first and last page. 
Rests are no longer left out when copying Smart Lines with Text from one document to another. 
 
Special Tools Tool  
Split stemming no longer causes the flag of the note to appear off to the side of the page. 
 
Speedy Entry Tool 
The Speedy Frame no longer appears to be in the wrong clef when using the left arrow key to move to the 
previous measure (Speedy Entry without MIDI). 
The whole entry is no longer deleted while pressing Backspace to delete an enharmonically altered note 
within a chord stack. 
 
Staff Tool 
Dragging a staff name in scroll view no longer repositions the abbreviated name. 
 
View Menu 



The keyboard shortcut for switching between staff sets now functions on Intel-based Macs. 

 
Fixes in Finale 2007 
 
Document Options 
Dotted double whole pickup measures can now be edited properly with Speedy Entry and Simple Entry. 
Entering 13 in resolution for curses in Documention Options-Lines and Curves in a file with a bracket 
present no longer crashes Finale.  
It is no longer possible to select a pickup measure larger than the time signature. 
 
File Menu 
If a pickup measure in a score contains a tuplet, the part will no longer extract with the first note of the 
tuplet missing. 
 
Graphics Tool 
When a blank page is inserted before a page with a graphic on it, the graphic no longer gets attached to the 
blank page.  
 
Lyrics Tool 
Files converted from 2005 across platform no longer have incorrect lyric baselines. 
 
Mass Edit Tool 
With Select Partial Measures selected, music within a pickup measure can now be copied. 
Altered Smart Shapes will no longer delete other Smart Shapes when drag-copied across staves vertically. 
 
MIDI Menu 
Finale no longer sends sync messages through inter-application MIDI when “Send MIDI Sync” is 
unchecked. 
 
MIDI Tool 
Edit Tempo now allows editing of partial measures. 
 
MusicXML 
Chord symbols in MusicXML documents are now always imported, creating chord suffix and playback 
definitions as needed. 
Chord symbols that the MusicXML exporter does not recognize are now exported as text. 
Smart word extensions now export more accurately. 
Symbols in the default music font will now export even for unrecognized fonts. The exporter assumes basic 
compatibility with Finale's standard fonts. 
Staves with chromatic transposition are now exported correctly. 
Imported page sizes are corrected for round-off errors to avoid the use of custom page sizes. 
 
Note Mover Tool 
Dotted notes on staff or ledger lines now move cross-staff properly. (The dot no longer collides with the 
line).  
 
Page Layout 
The dialog box “Optimize Staves” has been renamed “Staff System Optimization” for consistence between 
platforms. 
 
Playback 
The metronome countoff now observes tempo expressions, and uses the expression's tempo for the countoff 
accordingly (instead of the tempo set in the playback controls). 
The playback region is now respected in saved audio and MIDI files. 
 



Human Playback 
Human Playback now interprets slurs that connect notes of different layers. 
Glissandos leading to trilled notes now playback. 
Tremolos coming off a glissando now playback. 
Apply Human Playback applies the selected playback style to the end of the file starting with the first 
selected measures, not just to the highlighted measures. 
If a group of notes that are staccato are also slurred, the last note is no now interpreted properly. 
A rolled note that starts with a grace note (flam) is now interpreted properly. 
 
Printing 
Print Display Colors now works properly for the first print job.  
 
Simple Entry Tool 
Pick-up measures will now allow extra notes (i.e. for tuplets or grace notes). 
 
Smart Shape Tool 
When viewing two windows of the same document, deleting a Smart Shape in one window now deletes it 
in the other (a redraw is no longer required). 
 
Staff Tool 
When using Chromatic transposition, changes in the enharmonic spelling now consider the chromatically 
transposed part. 
 
Studio View 
If a staff name has 129 or more characters, Finale will no longer crash when switching to studio view. 
 
Tempo Tool 
The Tempo Tool now allows more than 64 Tempo changes per measure, which allows exacting tempo 
changes. 
 
 
 


